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3.1 Excel Dashboard: Tables and Data Grids 
 

Excel Dashboard: An Excel dashboard is a visual tool in Microsoft Excel that consolidates 

and displays data summaries, key metrics, and KPIs from various sources, providing a friendly 

overview of business data. It helps quickly interpret and analyze data, making it easier to 

understand key trends and make informed decisions. 

 

Key Features and Benefits of Excel Dashboards: 

 

1. Visual Representation: 

 

Dashboard present data in a visually appealing and easy to understand format, making it simpler 

to grasp trends and insights. 

 

2. Consolidated Data: 

 

They bring together data from multiple sources into a single, unified view, eliminating need to 

navigate through separate reports 

 

3. Interactive Elements: 

 

Dashboards often incorporate interactive features like slicers, timelines, and filters, allow users 

to explore data in more detail 
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4. Easy to Use: 

 

The intuitive design of dashboards makes it accessible to users of all technical skill levels 

 

5. Time-Saving: 

 

By providing a high-level overview, dashboards save time by allowing users to quick identify 

important information without having to sift through large datasets 

 

6. Improved Decision-Making: 

 

The clear and concise presentation of data in dashboards enables users to make bettes informed 

decisions based on accurate and timely information. 

 

Steps to Create an Excel Dashboard: 

 

1. Gather and Organize Data: 

 

Collect data from relevant sources and ensure it is properly organized and formatted in Exce 

 

2. Structure the Workbook: 

 

Design a layout for your dashboard including sections for key metrics, charta, and tables 
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3. Create Tables and Pivot Tables: 

 

Use Excel tables and PivotTables to organize and summarize your data. 

 

4. Visualize Data: 

 

Incorporate charts, graphs, and other visual elements to enhance the presentation of y data 

 

5. Assemble the Dashboard 

 

Combine all the elements of your dashboard into a cohesive and user-fmeully format. 

 

6. Add Interactive Elements: 

 

Use slicers, timelines, and other interactive features to allow users to explore data in more detail. 

 

Examples of Dashboard Elements: 

 

Charts: 

 

Bar charts, line charts, pie charts, and other types of charts can be used to visualize data trends 

and relationships. 

 

Tables: 

 

Tables can be used to present data in a structured and organized manner, making it easier to 

compare different metrics 
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Metrics: 

 

Key Performance Indicators (KPIs) and other relevant metrics can be displayed in a prominent 

way to highlight important data. 

 

Slicers and Timelines: 

 

These interactive elements allow users to filter data by different categories and time periods, 

providing greater control over the information displayed. 

 

Example: Consider an Excel sheet having data in tabular form 
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Now we can Discuss Above example more detail Through Some Graphical Images and Data 

assign in Excel sheet. Now consider following Excel sheet in which data is given that show 

Company Size with no of Employee with Revenue Generated in every month with according to 

country wise 
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Steps to Create an Excel Dashboard: 

●​ Step 1: Prepare Your Data 

●​ Organize data neatly in a table format (no merged cells). 

●​ Include columns like Date, Product, Region, Salesperson, Revenue, etc. 

●​ Select your data Press Ctrl+T to turn it into a Table (easier to manage). 

 

Department of Computer Engineering , Faculty of Polytechnic, YTC, Satara|                                               8 

 

 



 

 

Step 2: Create Pivot Tables 

Go to Insert PivotTable 

Create multiple PivotTables to summarize 

Total Revenue 

Revenue by Region 

Top Products 

Monthly Sales Trend 

Top Salespersons 
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Step 3: Insert Charts 

Select PivotTable 

Go to Insert Charts 

Choose the right type 

Pie chart for sales by region 

Column/Bar chart for top products 

Line chart for trends over time 

Donut chart for percentage metrics 
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Step 4: Design the Dashboard Sheet 

Create a new blank sheet called Dashboard 

Copy your PivotCharts and important Pivot Tables 

Arrange them neatly 

KPIs (big numbers) at the top 

Charts underneath 

Keep space and alignment clean 

Step 5: Add Slicers (Optional but Powerful!) 

Select PivotTable Insert Slicer 

Choose fields like Region Salesperson, or Product 

Slicers are clickable filters (very cool and interactive!) 
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Step 6: Furmat and Beautify 

Add nice titles (Insert-Text Box) 

Apply soft colors to charts 

Use consistent fonts and colors 

Hide gridlines View Uncheck Gridlines 
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3.1.1 Tables & Data Grids 

Skill What It Means Example I’ll Show You 

Tables and Data Grids Organized, sortable data Sales Table (with filters) 

Dynamic Filters and 

Controls 

Interactive filtering Slicers & Dropdowns 

Trend Analysis See how things change over 

time 

Line Chart of Monthly 

Sales 

Forecasting Predict future based on past Excel’s Forecast Sheet 

 

Tables and Data Grids Example 

In Excel : Create a Sales Table like this: 
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3.1.2 Dynamic Filters and Controls Example 

After creating PivotTables based on your Sales Table: 

Insert Slicer Select Region and Product 
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3.1.3 Trend Analysis Example 

Create a PivotTable: 

Rows→ Month (from Date field using Group by → Months) 

Values→  Sum of Revenue 

 

3.1.4 Forecasting 

If you want to show forecasting separately: 

 

Data Analytics with Excel 

 

Use formulas like FORECAST LINEAR() or FORECAST ETS() outside the pivot 
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Link those results to a secondary chart for future trend 

 

3.2 Pivot Tables: Creating Pivot Table, Specifying Pivot Table Data 

 

What is a Pivot Table? 

A Pivot Table in Excel is a powerful tool Pivot tables are one of the important and useful Excel's 

features that allow us to quickly summarize, analyze and explore large datasets whether it's sales 

Figures, financial reports or any complex data A pivot table helps us to rearrange, group and 

calculate data easily to spot trends and patterns without changing the original dataset Learning to 

create and customize pivot tables makes our data analysis faster, more efficient and turns raw 

data into clear, actionable insights. In this article we'll see the process of creating pivot tabies and 

its cors concepts. 

●​ Summarize large amounts of data 

●​ Analyze trends 

●​ Group filter sort and aggregate data nasily 

●​ Turn raw data into meaningful reports without writing formulas. 
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How to Create a Pivot Table in Excel? 

Follow these simple steps to build a pivot table in Excel: 

Step 1: Prepare Your Data 

Before creating a pivot table, ensure our data is properly formatted: 

Organize in a Tabular Format: Place our data in rows and columns with each column have header 

2. Avoid Blank Rows or Columns: Ensure there are no empty rows or columns within dataset. 

3. Name Your Data Range (Optional): Highlight our data and assign a name with Form Define 

Name for easier reference. 
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Step 2:Select Your Data 

1. Click any cell inside our data or 

2. Highlight the specific range we want to include in the pivot table 

Step 3: Go to Insert Tab > Insert the Pivot Table 

1. Go to the Insert tab on the Excel ribbon. 

2. Click PivotTable 

3. In the dialog box, check that the selected data range is correct. 

4. Choose where we want the pivot table to appear (new worksheet or existing sheet). 

5. Click OK to create the pivot table layout. 

In the Create PivotTable dialog box: 

1. Confirm the selected data range or adjust it as needed. 

2. Choose where we want the pivot table to be placed: 

●​ New Worksheet: Creates the pivot table in a new worksheet. 

●​ Existing Worksheet: Lets us place it in a specific location on the current sheet. 

Step 4:Build Your Pivot Table 

We'll see a pivot table field list pane on the right side of our screen. 

This is where we organize our data: 
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Drag and Drop Fields: 

Drag column headers from the Field List into one of the four areas: 

●​ Rows: Sets rows for the table. 

●​ Columns: Creates columns for our data. 

●​ Values: Adds numerical data to be calculated like sum, count, etc. 

●​ Filters :Adds filters to refine our analysis. 

 

Step Action Example 

1 Prepare Data Clean table with headers 

2 Insert Pivot Table Insert → Pivot Table 

3 Choose Range Auto detect or select 

manually 

4 Layout Pivot Table Drag fields into Rows, 

Columns, Values 
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3.3 Changing a Pivot Table, Calculations, Filtering and Sorting 

3.3.1 Changing a Pivot Table 

Sometimes after creating a Pivot Table, you might need to make adjustments or change the 

view of your data. Here's how to easily modify and update your Pivot Table. 

Step 1: Modify Field Placement 

●​ Drag fields between the areas (Rows, Columns, Values, and Filters) to change the layout. 

●​ Remove fields by unchecking them in the PivotTable Field List panel. 

Example: 

●​ If you want to add Salesperson to the Rows section, just drag the Salesperson field into 

Rows. 

●​  If you don't need to see the Product by month, simply drag it out of the Columns are 

Step 2:Adjust the Value Calculation 

●​ By default, Pivot Tables will sum numeric data, but you can change the calculation type 

to things like average, count, max, min, etc. 

●​ To do this: 

1.​  Click on the dropdown in the Values area. 

2.​ Choose Value Field Settings. 

3.​  Select the calculation type (e.g., Count, Average, Min, Max). 

Example: 

If you want to know how many transactions happened, use Count instead of Sum 
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3.3.2 Calculation in Pivot Tables 

Step 1: Create Calculated Fields 

Sometimes, you may want to perform custom calculations directly within your Pivity Step (like 

calculating profit margin or a custom formula). 

How to Add a Calculated Field? 

1 Click anywhere inside the Pivot Table 

2. Go to the PivotTable Analyze tab 

Calculated Field 3. Click Fields, Items & Sets 

4. Name the field and enter the formula. 

 

3.3.3 Filtering a Pivot Table 

Step 1: Filter by Specific Criteria 

Filters allow you to show only the data that meets your needs. 

How to Filter? 

1. Drag a field into the Filters area of the Pivot Table. 

2. This will create a dropdown in the Pivot Table where you can select specific items to filter 

Step 2: Use Slicers for Interactive Filtering 
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Slicers are visual filters that allow for easy and interactive filtering in a Pivot Table. They are 

especially useful for creating dashboards. 

How to Add a Slicer? 

1. Click anywhere inside the Pivot Table 

2. Go to PivotTable Analyze Insert Slicer. 

3. Select the field you want to filter (e.g., Region, Salesperson). 

4. Use the slicer to filter the data interactively. 

Step 3: Date Filters (for Time Series Data) 

If your data includes dates, you can use Date Filters to show data within specific time rang 

1. In the Pivot Table, click on a Date field in the Rows/Columns area. 

2. Click the dropdown next to the Date field. 

Choose a Date Filter such as This Month, Last 3 Months, Year-to-Date, or Custom Filter. 

3.3.4 Sorting a Pivot Table 

Step 1: Sort Data in Pivot Table 

You can sort your Pivot Table data based on any column (eg, revenue, units sold) 

How to Sort? 

1. Click the drop-down arrow in the field you want to sort. 

2 Select Sort A to Z (ascending) or Sort Z to A (descending). 
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Example: 

order If you want to see which region had the highest sales, sort the Revenue column in 

descending 

Step 2: Sort by Custom Order 

If you have custom categories (like Region), and you want to sort in a specific order [eg, North 

South East West), you can do the following 

How to Use Custom Sorting: 

1. Right-click on a Row Label in your Pivot Table (e.g. Region). 

2. Click Sort → More Sort Options. 

3 Choose Manual Order or Sort by Custom List. 

Step 3: Sort Data in Subcategories 

 

To sort data within categories, use Subtotals and Group By options 

How to Group Data? 

1. Right click on a Date field in Rows. 

2. Choose Group By and select to group by Months, Years, or Quarters. 

3. Now, you can sort within months or quarters. 

Advanced Filtering and Sorting (Optional) 
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1. Multiple Filters: Use Multiple Filters by dragging fields to the Filter area (eg, filter by both 

Region and Salesperson). 

2. Top 10 Items: If you want the Top 10 products by sales, go to Filter → Top 10 and select  

Top 10 by Revenue 

Example: Use Case for Pivot Table Changes 

●​ Let's say you have sales data, and you want to create a report that: 

1. Shows Total Revenue by Region. 

2. Filters by specific products (using a slicer). 

3. Sorts by highest sales. 

●​ Here's how you would do it: 

❖​ Create a Pivot Table. 

❖​ Drag Region into Rows. 

❖​ Drag Revenue into Values 

❖​ Add a Slicer for Product 

❖​ Sort Revenue in descending order. 

3.4 Creating a Pivot Table and Grouping Items 

Grouping Items in a Pivot Table! Grouping is a powerful feature that allows you to summarize 

and organize your data better For example, you can group data by dates (months, years) or 

ranges 

3.4.1 Grouping in a Pivot Table 
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Grouping in a Pivot Table lets you combine items in your data into larger categories. For 

example: 

●​ Date Grouping: Group by Month or Year instead of showing each individual day. 

●​ Value Grouping : Group data into ranges, like grouping sales into High, Medium, and 

Low ranges 

Step 1: Create a Basic Pivot Table 

1. Select your data. 

Make sure it's in tabular form (no merged cells). 

2. Go to Insert - PivotTable. 

3. In the dialog box, select New Worksheet and click OK. 

Step 2: Add Fields to the Pivot Table 

●​ Drag your Date field into Rows (so each date appears). 

●​ Drag Revenue (or any numeric field) into Values. 

Your Pivot Table might show a list of every day's revenue. 

How to Group Items by Date ? (e.g., Month or Year) 

Grouping Dates by Month or Year 

1. Right-click on any date value in the Rows section of your Pivot Table. 

2. Choose Group. 

3. In the Grouping dialog box, you can choose: 

 

Department of Computer Engineering , Faculty of Polytechnic, YTC, Satara|                                               26 

 

 



 
●​ Months 

●​ Years 

●​ Days 

●​ Quarters (You can select multiple options to group by both Months and Years). 

This groups your data by Month and Year instead of individual dates. 

How to Group Items by Numeric Values? (e.g., Revenue Ranges) 

You can also group by numeric values to create ranges, like grouping revenue into 

different brackets (eg, Low, Medium, and High sales). 

Here's how: 

1. Drag a numeric field (e.g. Revenue) into Rows or Columns. 

2. Right-click any numeric value in the Pivot Table. 

3. Click Group. 

●​ In the Grouping dialog box: 

●​ Choose Starting at and Ending at to define the range. 

●​ Set the By value (eg. Group by every 500 units). 

Example: If you choose to group Revenue by ranges of 1000, Excel will group all Revenue 

values into bins: 

●​ 0-1000 

●​ 1001-2000 

●​ 2001-3000, etc. 

3.4.2 Grouping Text Items (e.g., Product Names) 
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If you have a list of products and want to group them together into categories Electronics, 

Furniture, etc.), you can manually group text items. 

How to Manually Group Text Items? 

1. Ctrl-click on the items you want to group (eg. select two or more product names). 

2. Right-click one of the selected items 

3. Choose Group 

Now the selected items will be grouped together as a single category. 

Use Cases for Grouping in Pivot Tables 

●​ Date Grouping: 

○​ Analyze monthly sales trends instead of daily data. 

○​ Group by year to compare performance over multiple years. 

 

●​ Value Grouping: 

○​ Group Revenue into High, Medium, Low ranges to find patterns. 

○​ Group Units Sold into Small, Medium, Large categories. 

●​ Manual Grouping: 

○​ Group products into product categories 

○​ Combine similar regions into larger groups (eg., East and West regions into 

Coastal) 

3.5 Updating a Pivot Table 
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●​ This section shows you how to refresh existing data, and add new data to an existing 

Exce pivot table. When you create a new Pivot Table, Excel either uses the source data 

you selecte or automatically selects the data for you. But data changes often, which 

means you also n to be able to update your pivot tables to reflect the new or changed 

data. 

●​ To update a pivot table in Excel, follow these steps: 

○​ Refresh the Pivot Table: Click anywhere in the pivot table, then go to the 

PivotTab Analyse tab and click on Refresh. Alternatively, right-click the pivot 

table an select Refresh. 

○​ Change Data Source: If you need to update the data range, select a cell in the 

pivot tabi go to the PivotTable Analyse tab, and click on Change Data Source. 

Adjust the range as  needed and click OK. 

○​ Shortcut for Refreshing: You can also use the shortcut Alt + F5 to refresh the 

pivot table quickly. 

○​ Refresh All Pivot Tables: To refresh all pivot tables in your workbook, click the 

Refresh All button in the Data section of the ribbon. 

○​ These steps will ensure your pivot table reflects the most current data. 

Scenario: You have a pivot table containing sales data that needs updating with new 

data 

●​ In order to demonstrate how to update the data in your pivot table, let's look at the 

example we used in our lesson on How to Create A Pivot Table (link opens in a 

new window), where we summarized several months of sales data by different 

sales people in our team. 

●​ The situation now is that we have been given some additional data and need to 

incorporate this into our report. Specifically, we've been asked to include sales 
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data for an additional line of products (televisions) for the same time period as the 

original report. 

●​ Here's a sample of the sales data we used (note the number of rows obviously 

there is a lot more sales data in our report than is shown here): 
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 It's important to understand what these buttons do, and how they differ: 

The Refresh button will update your pivot table to reflect any changes in your existing 

data, such as any changes to our sales data due to customer returns. Using the Refresh button 

won't automatically pick up any new data in your table (unless you're using Excel's Table feature 

as the source for your pivot table - we'll come to that shortly). Note that you can also choose to 

refresh your data by right-clicking anywhere in your pivot table and choosing Refresh from the 

menu. 

 

 

 

3.5.1 Formatting a Pivot Table using Slicers in Excel 
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1. Refreshing the Pivot Table (When New Data is Added) 

After you've created a Pivot Table and your data changes (like adding new rows or modifying 

existing data), the Pivot Table won't automatically update. You need to refresh it to reflect the 

changes. 

How to Refresh a Pivot Table? 

●​ Right-click anywhere inside the Pivot Table. 

●​ Click Refresh. 

●​ This will update the Pivot Table and incorporate any new data that has been added or 

modified. 

●​ Automatic Refresh on Opening a Workbook (Optional) 

If you want the Pivot Table to refresh automatically whenever you open the workbook: 

●​ Click anywhere inside the Pivot Table. 

●​ Go to the PivotTable Analyze tab. 

●​ Click Options-Data. 

●​ Check the box for Refresh data when opening the file. 

●​ Now, your Pivot Table will automatically refresh every time you open the file! 

2. Updating the Data Source (When Data Structure Changes) 

Sometimes, you may add new columns to your source data (e.g., adding a new "Discount" 

column to track discounts). If you don't update the data source, the Pivot Table won't recognize 

these new fields. 

 

How to Update the Data Source ? 
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●​ Click anywhere inside the Pivot Table. 

●​ Go to the PivotTable Analyze tab. 

●​ Click Change Data Source. 

In the Change PivotTable Data Source dialog box: 

●​ Adjust the range to include new columns or rows. 

●​ If you have turned your data into a Table (via Ctrl + T). 

●​ You can just update the table, and the Pivot Table will auto-update to include any 

changes. 

3. Modifying Field Settings and Adding Calculations 

After creating a Pivot Table, you may want to update how data is calculated or displayed (for 

example, changing the calculation from Sum to Average). 

How to Modify Field Settings? 

Click the dropdown arrow next to any value in the Values area of the Pivot Table. 

Select Value Field Settings. 

In the dialog box, change the summary calculation to: 

●​ Sum 

●​ Average 

●​ Count 

●​ Max/Min 

 

Custom Calculations (like % of Total, Difference From, etc.) 
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4. Adjusting the Layout (Changing the Structure of Your Pivot Table) 

As your needs evolve, you may want to update the layout of your Pivot Table (eg, changing 

which fields are in rows or columns). 

How to Adjust the Pivot Table Layout ? 

●​ Click and drag fields in the PivotTable Field List. 

●​ Drag a field to the Rows or Columns to change how the data is arranged. 

●​ You can also remove fields by unchecking them in the PivotTable Field List 

5. Grouping and Ungrouping Data 

If you need to change how your data is grouped (eg, you initially grouped by Month and want to 

switch to Year), you can easily update groupings 

How to Group or Ungroup Data ? 

●​ Right-click any item in your Pivot Table 

●​ Select Group or Ungroup from the context menu. 

●​ If you need to change the grouping criteria (eg, changing from months to quarters te 

days). 

●​ Right-click on the group and choose Group again. 

●​ Update your grouping settings (eg, select Quarters instead of Months). 

6. Sorting the Pivot Table Again 

If the data in your Pivot Table needs to be re-sorted after you refresh or add new data, yo can 

reapply sorting options. 

How to Sort: 
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●​ Click the down arrow next to any field in the Rows or Columns area. 

●​ Choose to sort either A to Z (ascending) or Z to A (descending). 

●​ Alternatively, you can right-click on the Row or Column label and 

●​ Select Sort - Sort Largest to Smallest or Smallest to Largest. 

7. Removing or Adding Filters 

If you have filters applied to your Pivot Table (eg, filtering by Salesperson), you can add or 

remove filters at any time. 

How to Update Filters ? 

●​ Click the drop-down arrow next to a filter field in your Pivot Table. 

●​ Choose new criteria to filter the data. 

●​ You can select multiple items, clear the filter, or filter by color. 
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